Development document for:
Montréal Market Vendors ca 1880 web-map - Based on Lovell's City Directory 1880-81 database from
Montréal, l'avenir du passé (MAP) project: http://www.mun.ca/mapm/eng/about_frame.html
Using: ArcGIS Online (AGOL) (https://doc.arcgis.com/en/arcgis-online )
Link to webmaps: The final AGOL web mapping apps are viewable at:
http://hgisportal.esri.ca/portal/apps/MapAndAppGallery/index.html?appid=f081eb9a363c46caa37c7
7d132def423
Lovell in Montréal 1880 Basic Web App: Original layers and ArcGIS Basemap
Montréal Market Vendors Work and Home ca 1880 Filtering App
GOAL: To demonstrate one example of investigative study of a GIS database using publicly available
online tools for GIS analysis and mapping.
Explanation: The "Montréal, l'avenir du passé" ("MAP") project has published a number of databases based on
original source documents for Montréal in the 19th century. An exercise for studying the nature of public markets
in Montréal based on vendors as identified in the Lovell's City Directory 1880-81 was developed by Prof. Robert
Sweeny of Memorial University to be done by students using GIS software (QGIS). The goal was to demonstrate
how this project could be done using online tools, so that only data and browser access would be needed for
students.

REQUIREMENTS: The Montréal, l'avenir du passé (MAP) website allows the downloading of the
Lovell's 1880-81 database in spreadsheet form. The GIS base map data associated with the Lovell's
data is also available from the project, including buildings and lots identified by land use, and points
representing individuals or firms identified by address. The requirements for this exercise were to
identify the individuals working in the markets and link their work locations to their home addresses,
then to map these links using lines to connect the points. Once this was accomplished, students were
to use the mapping interface to explore the differences between markets in terms of the people
working in them, their occupations, and their assumed journeys to work.
SEE APPENDIX 1: The context and steps involved for the Market Vendors study as envisaged was
outlined by Prof. Sweeny in the document "Scenario for markets based on MAP’s 1880 Lovells QGIS
application" (Appendix 1 at the end of this document.)
Credits: Montréal l'avenir du passé project, Robert Sweeny, Sherry Olson, Canadian Historical GIS
Partnership Development project, GIS and Cartography Office Dept of Geography University of Toronto
Programming assistance: Haydi Wong, CHGIS Research Assistant
Approach: Unlike our other pilot projects, which focus on functionality of software and custom coding
for map design and presentation, this project is primarily about enabling the user to analyse and explore
data interactively. Therefore rather than a breakdown of the code required to produce a final web-map,
this documentation will consist of the step by step process of using ArcGIS Online's tools to achieve the
objectives of the exercise. The decision was made to use latest tools from AGOL, including the new
Analysis tools, as of date of production (mid-2017) as much as possible for completing this exercise.
Note: The ArcGIS Online documentation is extensive and comprehensive, therefore many details will
be referenced to that documentation rather than explained in full here. See:
https://doc.arcgis.com/en/arcgis-online/
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Functionality:
Mapping and GIS functionality: ArcGIS Online is the online data-upload and webmap design interface
from Esri.com. ArcGIS online map applications can be visible to all, but to upload data and run analyses
it requires users to sign up for an account. This may be a free public account, within usage limits.
Organizational accounts are available, and students can get access to education accounts through most
universities. For this pilot project we used the University of Toronto organizational account, which used
the most up-to-date version of ArcGIS Online and was available for research purposes.
Map Data: All data uploaded from shapefiles from "MAP" project to ArcGIS Online feature datasets
Overlay Mapping data:
Lovell Directory points: lovellinmtl.shp - 34,650 features representing individuals or firms recorded in
the Lovell's City Directory 1880-81 georeferenced by address. Attribute fields for points used herein:
ENTRY: Transcription of Entry in Directory: typically name of person or institution, firm (if
applicable), description of occupation or business (if applicable)
LID: Lovell's Directory Entry Unique ID (person or firm)
LOVPTSID: Lovell's Directory Points Unique ID for Points - if more than one address is listed for a
person (eg. work, home) the georeferenced points would have same LID, different LOVPTSID
(NOTE: Duplicate LOVPTSID values were found in the MAP data, and needed to be edited see "Note: ISSUE REGARDING UNIQUE LOVPTSID" in text below.
ADDRESS: Street number and name, sometimes qualified as h or r (home, rear) or w (work)
ADDRESS2 (also 3 and 4): Supplemental addresses if applicable
FIRMORINST: Values coded as Person: 0; Firm or institution: 1
Lots: g80_lots.shp Lot polygons. The lots will be used to identify where markets were located.
Institutions: g80_inst.shp Contains building footprint polygons for various institutions in Montreal. The
layer is used to identify the location of markets.
Background Mapping data: Shapefiles for Wards, Streets, Railways, Wharves, Beaches, River, Canal,
Park
Base map: ArcGIS Online "Light Gray Canvas" suitable for thematic overlay.
Tabular data:
Lovell's City Directory Database 1880-81 (detailed): LOVELL80.DBF (DBase file)
Includes detailed parsing and codification of City Directory entries into multiple fields to facilitate
analysis. Fields break down name into components, identify females, widows, building and locational
information such as front or rear addresses, etc. Only field used in this analysis was OCCUPATION.
Notes re: Montréal, l'avenir du passé "MAP" project data
These data are available publicly through the Montréal, l'avenir du passé project website, through the
Applications tab, at: http://www.mun.ca/mapm/app/app_frame.html . Download the Goad 1880
Windows application data. The detailed Lovell's City Directory 1880-81 data is available on the Database
tab, at: http://www.mun.ca/mapm/data/data_frame.html
OVERVIEW OF WORKFLOW IN ArcGIS Online
Since the goal of this exercise was to accomplish analysis and visualization using Online tools only,
source shapefiles and tabular data files were uploaded to the AGOL account and hosted feature layers
created from them there. ArcGIS Online web maps were made by layering and symbolizing these files
appropriately, and Analysis tools used to process data to accomplish the goals of the project - joining
data layers, extracting data, and connecting origin and destination points with lines. When layers
representing the results of the analysis were complete, these were loaded into a new web map for
deployment as a AGOL web mapping Application. The exceptions to this process were the creation of
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the map to simulate the original "MAP" QGIS project map, and the use of Excel on a local computer to
do some data validation. The steps below outline the entire process.
PRODUCTION NOTES
OVERLAY MAPPING DATA
Projection of map data
The projection of the shape files provided by the MAP project is not identified within the shapefile (i.e.
no .prj file is provided) however the QGIS document uses the Coordinate Reference system EPSG:2950,
NAD83(CSRS) / MTM Zone 8 (a modified Transverse Mercator projection used commonly in Quebec. The
coordinate data for the files are consistent with this projection as well. It was decided to re-project all
shapefiles to the Web Mercator Auxiliary Sphere projection (EPSG:3857) to simplify upload. These layers
were reprojected and given a suffix of "wmas" for ease of identification: eg: G80_lots_wmas.shp. This is
the default projection used in ArcGIS Online and after projection caused no issues in this environment.
Visualization of QGIS map layers
The MAP project data is downloaded as shape files, along with QGIS project documents which reference
them. The Lovells data is visualized in the project document: Lovells 1880 directory.qgs. Using QGIS to
open and examine this project document is a good way to understand the various layers in the database
and the attribute data attached to them. As a first step in the project it was decided to duplicate this
QGIS map using ArcGIS Desktop (ArcMap), to validate the uploading and visualization of data layers. This
could be done in ArcGIS Online as well, but was easier done in ArcMap. See illustration below.
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Creating AGOL Lovell in Montréal Basic Web Map and App
The ArcMap document of Montréal base map features was published to the Canadian HGIS portal
ArcGIS Online as a Tiled map service with feature access. This allows for speedy drawing of detailed and
numerous point and polygon data as well as access to attribute data for feature pop-ups and searching.
See: https://hgisportal.esri.ca/arcgis/rest/services/MontrealAP/Lovell_MXD_WAS_20170524_tiled/MAPServer
This map service was then added to the U of T ArcGIS Online organizational account Contents list by Add
Item -> Add Item from web, adding it as an ArcGIS Server web service. See illustration below:

The service was incorporated into a web map, and ArcGIS web app builder was used to build a simple
application which allows clicking on individual Lovell points to trigger popups, as well as searching for
Lovell point records by Street name. The map is available at:
http://utoronto.maps.arcgis.com/apps/webappviewer/index.html?id=8daf52e9168748db8f52df20350325ae
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STEP-BY-STEP MARKET VENDOR ANALYSIS EXERCISE USING ArcGIS ONLINE
(Refer to Appendix 1: Scenario for markets based on MAP’s 1880 Lovells QGIS application)
1. Upload Lovell in Montreal necessary Shapefiles to AGOL, using Web Mercator versions
Login to Utoronto ArcGIS Online organization, as CHGIS_RA (or comparable AGOL account)
Create new Folder under My Content\Montreal_AP_AGOL
Upload necessary Lovell in Montreal shapefiles as below to AGOL, using Web Mercator versions
Use: Add Item -> from my computer (from local directory Montreal_AP_AGOL)
Shapefiles:
lovellinmtl_3857.zip (converted from original lovellinmtl.shp to WMAS also known as EPSG 3857)
g80_inst_wmas.zip
g80_lots_wmas.zip
Create a new web map containing these three layers, in the order above, and symbolize for easy
visibility. We called the map: Market Vendors Analysis 1880 AGOL
2. Select Lovell point locations in lots which contain buildings identified as "market"
In the web map "Details" window, on the Institutions layer, click on the Filter icon. This will bring up a
Filter screen. We want to to isolate buildings which contain markets. On the Edit tab, display features
that match the expression: "type_eng" is "market". See screen capture below:

The filter above selects 21 buildings. Viewing the map around these, we can see that many of the point
entries from the Lovell directory are located on either the building or on the lot around it. If we selected
5
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points which intersected the buildings, we would miss quite a few. Therefore we will select the lots on
which the buildings are located.
To do this use the Analysis tool Join Features, with the join type as: Spatial relationship.

The target layer is the Lots layer.
The Join layer is the Institutions layer.
Since we have used a Filter on this to
isolate market buildings, only those
will be used in the Join Analysis.

The type of Join - Spatial relationship is
"Intersects." This will include lots
which contain market buildings that
take up the entire lot, or even overlap
the boundaries of the lot. (Safer than
using "Completely contains.")
Join operation is one to one.
Resultant layer name:
"Join Intersect market Institutions to
Lots"

The resultant layer contains 9 features; these are Market lots i.e. lots which contain market buildings.
To select the Lovell point locations which intersect with these Market lots, we again use the Join
Analysis and a spatial join type.
Target layer: Lovell Points
Join layer: Join Intersect market Institutions to Lots
Join type: Spatial - Intersects Join operation: Join one to many
Resultant layer name: Join Intersect Lovell Points to Market Lots
The resultant layer contains 489 features; these are the Lovell point locations within Market lots.
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3. Identify Lovell Point locations within Markets that represent duplicate individuals and delete
It was found that some of the Lovell Point locations within Markets represent the same individual, i.e.
had the same unique identifier (LID). To make sure work locations are only counted once, these should
be removed. Identifying these does not appear to be easily done using the statistical tools within ArcGIS
Online.
There are a number of alternate ways to do this. We exported the Layer as a .CSV file using the Analysis
tool: Extract Data. We named this file:
Join Intersect Lovell Points to Market Lots 489.csv
We downloaded the file to a local computer and used Excel to identify duplicate LIDs. (Conditional
Formatting -> Highlight cells -> Duplicate values. Then Filter by Color to isolate these.) We found there
were 9 duplicate LIDs. We recorded these and then returned to the web map in ArcGIS online.
In ArcGIS Online we want to make a copy of our Lovell points layer to edit it. We can use Export Data ->
Export to Feature Collection to copy the Join Intersect Lovell Points to Market Lots layer and renamed it:
Lovell Points to Market Lots 480. We then have to Publish the layer, to make it a hosted feature layer
which can be edited: Lovell Points to Market Lots 480 hosted.
Once we have created and published this layer, we have to make it editable in the Layer Settings ->
Enable Editing. For more details see:
https://doc.arcgis.com/en/arcgis-online/create-maps/edit-features.htm
We bring this into our map as a new layer. We then select each duplicate LID value using the Filter tool
with Unique values: See image below.
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Examining the two points that were identified with the same LID we determined which was most likely a
"work" location and which was most likely a "home" location within the market lot (identified by the
prefix "h" or described in the entry in some way such as "over St. Ann's market"). Some of these were
either a second work location in the same market (for example, a second market stall owned by the
same vendor) or a second work location in a different market owned by the same vendor. We deleted
all of the presumed home locations from the feature layer, leaving 481 points with unique LIDs. Rename
the layer: Lovell Points to Market Lots 481 hosted.
4. Identify Lovell Points to Market Lots as WORK locations, and find corresponding HOME locations
It is assumed that all of these points in Lovell Points to Market Lots 481 hosted are Market Work
locations. Create a new text field WORKORHOME and use "Calculate Field" to assign the value 'WORK' to
all of these points.
For convenience, use Export Data - Export to Shapefile to create a new shapefile of work locations. Call
it: Market Work Locations. Use "Publish" to Publish this item as a hosted feature layer. Add this to the
web map.
To find the corresponding HOME locations, use the Analysis "Join Features" tool again, to join the
Market Work Locations to the full original Lovell Points layer, using the unique LID as the join item.
Then in a second step, we will identify HOME locations, which will be the ones outside of Market Lots.
Target layer: Lovell Points
Join layer: Market Work Locations
Join type: Choose field to match
Join field: LID
Join operation: Join one to many
Resultant layer name: Join LIDs Lovell Points to Market Work Locations
The resultant layer has 894 points. Since it was joined to the Market Work Locations file, the value for all
records for WORKORHOME is 'WORK'. We can identify HOME locations by selecting those points which
do not overlap on the Market Lots layer we created previously - we can then reassign the value of
WORKORHOME to 'HOME' for these points.
To do this, use the Analysis -> Find Locations -> "Find Existing Locations" tool.
Layer to query: Join LIDs Lovell Points to Market Work Locations
Expression: Does not Intersect
Intersect layer: Join Intersect Market Institutions to Lots
Resultant layer: Join LIDs Lovell Points Home Locations
The resultant layer has 403 points. For all of these, use Calculate Field to assign WORKORHOME =
'HOME".
For convenience, use Export Data - Export to Shapefile to create a new shapefile of home locations. Call
it: Market Home Locations. Use "Publish" to Publish this item as a hosted feature layer. Add this to the
web map.
5. Create Unique IDs to use for Connecting Origins and Destinations
We can use the Analysis tool "Use Proximity -> Connect Origins and Destinations" to draw lines between
corresponding Work and Home locations. However, a condition for this tool is that there must be the
same number of records in each layer, i.e. a one-to one match between Origins and Destinations.
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This is not currently the case since we have 481 Work locations and 403 Home locations. Therefore we
need to edit our Market Work Locations layers to ensure that all Work locations have a corresponding
Home. We can achieve this by using the Analysis "Join Features" tool again, to join the Market Work
Locations layer to the Market Home Locations layer, using the unique LID as the join item, and a one-tomany join. This should ensure the same number of matching locations.
Target layer: Market Work Locations
Join layer: Join LIDs Lovell Points Home Locations
Join type: Choose field to match
Target field and Join field: LID
Join operation: Join one to many
Resultant layer name: Market Work with matching Market Home Location
The resultant layer has 403 points, the same as the Home Locations. We will use these as our origin and
destination layers for to connect work and home locations.
6. Add Occupation data to Market Work with matching Market Home Location
As described in Appendix 2 below, we have already created a table which contains Occupational data
identified by LID. Bring this table into the map by using "Add Layer from File":
Table: lovellinmtl_lid_occupations_revised.csv
Use Analysis "Join Features" tool again, to add the Occupation categories to the Market Work with
matching Market Home.
Target Layer: Market Work with matching Market Home Location
Join layer: lovellinmtl_lid_occupations_revised.csv
Join type: Choose field to match
Target and Join field: LID
Join operation: Join one to one
Resultant layer name: Market Work with matching Market Home Occupation
The field: OCCU_REV contains the 10 Occupational categories we will use.
The same method should be used to add the Occupational data to Market Home Locations, which will
be useful when symbolizing these on the final web map application.
Resultant layer: Market Home Locations w Occupation
7. Run Connect Origins and Destinations tool
The Connect Origins and Destination tool was run, using these layers, and LID as the linking field. It
resulted in an error message:
"The LID in Market Work with matching Market Home w Occupation does not have unique values.
Connect Origins to Destinations failed." This makes it clear that not only do the two files need to have
exactly matching records, but that the linking fields have to have unique values. This is not the case, as
we know that LIDs occur more than once, when the same individual or firm has more than one home or
9
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business location. To identify the re-occurring LIDs, we can again Export Data to a .CSV file, and use a
program such as Excel, outside of AGOL. On re-examining the files, it was realized that since the
LOVPTSID field for the Home Location could be used for this purpose, since it was linked to the Work
locations) and so occurs uniquely in both of the specified files (renamed via Join tool as LOVPTSID_1_1 in
the Market Work matching file.)
Connect Origins and Destinations was run as follows:
Origin layer: Market Work with matching Market Home w Occupations
Route to destinations in: Market Home Locations
ID field in origin: LOVPTSID 1 1
Matching ID field in destinations: LOVPTSID
Measure: Line distance
Result layer name: Market Work connect to Market Home w Occupation
(Note: ISSUE REGARDING UNIQUE LOVPTSID values: Two points had duplicate values for LOVPTSID:
43650. One of these points was changed to a value out of range: 49990, to allow a correct matching to
occur. Upon examination it was discovered that many LOVPTSID values were duplicated. This issue must
be dealt with - probably the best way is to assign new unique point ID values at start of analysis.)
This succeeded in drawing the connecting lines. See illustration below for list of all analysis layers and
raw symbolization.
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8. Create Market vendors web map and symbolize Market Vendor data by Occupation category
In order to deploy a web map application in ArcGIS Online, we needed to create a streamlined version of
the analysis map. We saved a copy of the Market Vendors Analysis map, and renamed it Montréal
Market Vendors Work and Home ca 1880. We deleted all the intermediate working layers used for the
analysis, leaving just the three final layers of Market Work and Home locations (with Occupation) and
Connecting lines between them. As mentioned above, an Occupation category attribute had been added
to each Market vendor work and home location. When Origin-Destination lines are generated, the fields
are included in the attribute table for connecting lines. For each layer, use the "Change Style" interface
to automatically colour-code these symbols. The default colour-coding works quite well to differentiate
Occupation types, and it is applied consistently to each of the layers (based on similar frequencies of
each type in each layer.) Of course this could be customized as desired. See illustration below:

This illustration also shows a change in the base map used. The Esri Light Gray Canvas base map was
chosen as a useful neutral background for our thematic information colour-coded by Occupation. The
tiled feature layer used in the Lovell in Montréal 1880 Basic Web Map and App was also included as a
background layer. This was displayed at a transparency of 75% to reduce its visual impact, again to
highlight the thematic occupational data.
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9. Create Web Application with capability of isolating Occupation categories
The layers in the web map Montréal Market Vendors Work and Home ca 1880 were customized to
enable pop-ups when clicking on the Market work and home locations, with a selected number of useful
and comparable fields (including the ID fields LID and LOVPTSID, the ENTRY field, and the OCCUPATION
field) made visible when the user clicks on them. The Work locations were also differentiated from the
Home locations by a black outline around the former and white around the latter.
The web map Application was generated from the web map using the "Web App Builder for ArcGIS." The
"Foldable Theme" was used as the base template. The Search Widget was customized to allow searches
of the Market Home Locations by street name i.e. searching the ADDRESS field.
The main addition to the theme was the Group Filter widget which adds the capability to isolate and
visualize individual Occupation categories. The widget was added to the Header Controller in the top
right of the application window, and set to be visible upon initial opening of the app. The filter was
named "Group Filter by Occupation." Filter groups were made for each of the 10 occupation categories.
For each one three layers were included: Market Work locations, Market Home Locations, and the
Connecting lines, with the Occupation field specified as the filter field for each (OCCU_REV or
equivalent.) See illustration below for Group Filter widget configuration screen.

12

Montreal_Lovells_Market_Devt_AGOL_20180115.doc

The result of this is to add a widget to the right hand panel of the app which allows the user to isolate
the set of points and lines associated with each occupation category. See image below for the example
of "Butcher."

The map and tools provided by this app can be used by students to explore the data and the spatial
relationships between the work and home locations of market vendors in these occupational categories.
More to the point, the process outlined here demonstrates the utility of the ArcGIS Online platform and
tools for posing many kinds of unique, purpose-built questions supported by the data collections of the
Montréal, l'avenir du passé project.
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APPENDIX 1
Scenario for markets based on MAP’s 1880 Lovells QGIS application
Prof. Robert Sweeny, Memorial University of Newfoundland
As is still the case in many parts of the world, people in 19th century Montreal bought most of their food
at markets. There were both neighbourhood markets and a large central market in the heart of the city.
From west to east St Gabriel, St Antoine, St Anne, St Laurent, St James and Papineau wards each had
their own market, while Marché Bonsecours on St Paul Street served as the main market. In addition
there was a wholesale cattle market adjacent to the newly constructed Canadian Pacific railway line in
the east end of the city centre, on Craig street, and a hay and horse market to the west, near the Grand
Trunk Railway station on Chaboillez Square.
In the Lovell’s city directory it was frequent for people who leased stalls in the retail markets to also list
their home address. These addresses are an indication of how local the ward markets were. In this
exercise we will be comparing this residential information with other variables to assess the character of
these differing markets.
Understandably, markets were located near where people lived. The simplest way to see where they
were is to select the institutions layer and query for the word market in the name field. The syntax of
your query should look like this:
“Nom_name” ilike ‘%market%’
Using the operator ilike makes the query case insensitive, and by bracketing ‘market’ with %s searches
for this word anywhere in the field. Please note the differing types of quotation marks used. QGIS uses
doubles for fields, but singles for search items.
This will highlight 23 buildings. Use the information cursor to click on a highlighted building, and then
zoom in to see the immediate area. Note how many entries from the Lovell’s directory are located
either on the building or its lot. Repeat this zooming in and out for each of the markets. All but the
wholesale markets for cattle, horses and hay have numerous entries on their lot.
In constructing this HGIS, Lovell’s entries were placed on lots, rather than in specific buildings, so
although we correctly located each market by querying on its name this was not the best way to
proceed. As you have just seen, for some markets the points representing people or businesses, while
lying within the lot, were sometimes not positioned over the top of an actual building. Thus, if we used
this method to select people working at the market we would miss quite a few.
The solution is to select the lots where institutions called markets were located. This is easy to do and
the first step we have already accomplished – we have selected the buildings. Now we do a spatial
query, available from the Vector tab’s pull down menu. Select the lots layer and then the institutions
layer, agreeing to restrict this selection to those lots containing all or part of one of the 23 buildings
selected (use "intersect", not "contain"). Nine lots will be selected and the results of the query will
appear in a window on the screen. Use the “zoom to item” feature to see each of lots in the list. You will
note that the St Anne’s market consists of two adjacent lots.
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Now we repeat this procedure, but this time to select point entries which "people" these lots. A spatial
query for entries within these nine lots identifies 490 separate points. To see who these people are, click
on the database icon from the top menu and then click on move selection to the top (the icon with the
little up arrow). Now we are ready to view our people working in these markets, but it would make
sense to look at those working in the same market together, so click on title of the Map_link column and
the entries will be re-ordered by lot number. MAP uses the same ward-based numbering system in all its
1880s applications, so we have now effectively spatially organized our people starting with the
Bonsecours Market in the East ward. As you scroll down the highlighted table you will see differing
markets appear, but you will not see most of the entries, so adjust the column widths, so that the
address and entry fields are visible. Note how frequently a second address, and very occasionally a third,
appears. Most of these are preceded by the letter h, which means this is their home address.
Each address given in the alphabetical listing of Lovell’s within the city limits was given a point, so
people with multiple addresses have multiple points. They have same id number (LID) but more than
one point id (LOVPTSID). What we are going to do is create lines out of the points for each these
multiple entries.
[… Here Sweeny included a section on how to generate lines from a set of points paired up by matching
on a a common field in QGIS. Not necessary here as the methodology for our web-mapping sites is
completely different.]
If you look at the entries for each of the markets, most are dominated by various types of butchers
stalls. This is understandable as most meats are not seasonal in the way that fruit and vegetables are
and these stalls were rented for the entire year. But also many of the people selling at these markets
were farming families who sold their produce out of the back of their carts and they would not have had
need to rent a stall.
Markets were not the only place to buy food. Green grocers were ubiquitous, with more than a
thousand listed in Lovell’s. Many of the employees of the butchers owning the stalls in the markets gave
butcher as their occupation and their residence, but not who they worked for, is provided by the Lovell’s
alphabetical listing. More than 340 fruit and vegetable dealers and 230 bakers are also listed. There is no
sure way of knowing, save for the 65 milkmen, if the address given by most of these people active in the
food industry was where they worked or not. In most cases, it was probably their home. If the address is
on a major commercial street it is, however, probably a good indicator of their workplace, as few earned
enough to pay the high rents these streets commanded.
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APPENDIX 2: Occupational classification
OCCUPATION as described in the Lovell's City Directory file was transcribed verbatim, and so needed to
be classified and coded for any systematic occupational analysis. Prof. Sherry Olson of the "MAP" project
had developed an occupational coding scheme for the census database of the project, so it was decided
to adapt that coding for Lovell's. Prof. Olson established 247 occupational classes using 3-letter codes
from ACC for Accountant to WOO for Wood dealer. These were based on occupational descriptions in
the City of Montréal Tax Rolls in the late 19th century. Part of her explanatory correspondence runs:
"Often ambiguous, as you know, are complex titles like 'hardware dealer' or 'hardware merchant' -- for
assignment to merchant, dealer, or trader, On the whole, in Montreal, the merchants are the big fish
and the traders are the small fry, dealers are a mixed bag. We devised our coding system from the
taxroll data, but Lovell's is more specific than the taxroll about such commercial occupations."
Time constraints made it necessary to limit the coding for our pilot project to the selected records
required for the Market Vendors analysis, rather than to code all records. Therefore it was only done
after the "Select points that intersect with Market Lots" step explained above, so that we had 480
occupations to code. This was done by a preliminary analysis of the Lovell's City Directory OCCUPATION
field for the selected records, and then assembling a set of search terms to look for in that field, for
example "butcher" and "meat" were used to assign the occupation of "BUTCHER".
We ended up with 34 occupational classifications and codes. This would be too many to effectively map
using colour coded symbols. Also some codes were not true occupations (such as "Widow") or occurred
in insignificant numbers (such as "Fireman"), or were placeholders indicating no substantive information
was provided about occupation (such as "Name only".) Therefore the occupational classes were
reclassified into 10 consolidated groups, for the purposes of mapping, and these were assigned to the
points in the Market Vendors shapefile. The original occupation classes and the consolidated groups are
listed in the table below.
Detailed Group
butcher
grocer
seafood
trader
armory
basketmaker
butter dealer
clerk
clothier
confectioner
dealer
fancy goods
glassworker
jeweler
merchant
storekeeper

Consolidated Group
BUTCHER
GROCER
SEAFOOD
TRADER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER
DEALER

Detailed Group
provisions
bartender
refreshments
restaurateur
farmer
florist
gardener
address name only
market name only
name only
person name only
caretaker
fireman
lead and color
painter
telegrapher
widow

Consolidated Group
PROVISIONS
RESTAURATEUR
RESTAURATEUR
RESTAURATEUR
FARMER
FARMER
FARMER
NAME ONLY
NAME ONLY
NAME ONLY
NAME ONLY
UNCLASSIFIED
UNCLASSIFIED
UNCLASSIFIED
UNCLASSIFIED
UNCLASSIFIED
UNCLASSIFIED
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